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APPENDIX E: LEXICONS

A. Overview

1.

What is a lexicon?

2. Why should | use a lexicon?

3. How can | expand my data
search capabilities by using
a lexicon?

4. What lexicons are included
in ICMS?

5. Can | add additional
lexicons to ICMS?

B. Nomenclature 3.0

1. What is Nomenclature 3.0?

2. How do | use Nomenclature
3.0 lexicon in ICMS?

ICMS User Manual (2015)

A lexicon is a standardized vocabulary or dictionary of terms. It establishes
relationships between words by placing them in categories within a
hierarchy. A lexicon allows you to select the most appropriate term. It also
allows you to move from that term to a broader, narrower, or related term.
Use a lexicon to:

e act as an authority table

e  establish a relationship between words

e expand your capability to search your database

e  maintain consistency in data entry

Lexicons allow you to search by categories or by groups of terms rather than

searching for each term individually. For example, you can search for

Building Materials, rather than individual types of building materials, such as

brick, nail, or mortar.

ICMS includes several lexicons:

e Nomenclature 3.0 for Museum Cataloging: Third edition of Robert G.
Chenhall’s System for Classifying Man-Made Objects by Paul Bourcier,
Ruby Rogers, and the Nomenclature Committee, AASLH Book Series,
published by AltaMira Press, January 16, 2010.

e NPS Classification Terms based on the NPS Museum Handbook, Part 11,
Museum Records (MH-II).

e  Hierarchical Classification Outline (HCO) from the MH-II.
e Integrated Taxonomic Information System (ITIS)

o Art & Architecture Thesaurus (AAT) published by Oxford University
Press, 1994-2009, for The Getty Art History Information program.

Yes. You can add unit lexicons to ICMS. Refer to Section I of this chapter
for information on unit lexicons.

Nomenclature 3.0 is a system for classifying and naming historic material.
The system is based on an object’s original function.

You must use the Nomenclature 3.0 lexicon to classify and name history
objects. The classification categories and object terms appear in tables
within ICMS. Access the classification terms in Classification Lines 2, 3
and 4. Access the object terms from the Object field. Refer to Section IV of
Chapter 2 for information on cataloging history objects.
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3. Where do I go to find
information on
Nomenclature 3.0?

4. Can | add terms to
Nomenclature 3.0?

C. NPS Classification Terms

1. What are the NPS
Classification Terms?

2. How do | use the NPS
Classification Terms lexicon
in ICMS?

3. Where do I go to find
information on the NPS
Classification Terms?

4. Can | add classification
terms?

Appendix E/Lexicons

There is also a Revised Nomenclature field on the archeology specialty
screen. This field allows you to use the Nomenclature .3.0 lexicon with
historic archeological material.

From any memo field in the program, you can access a list of
Nomenclature 3.0 and AAT terms to use as vocabulary.

Note: To access the Nomenclature 3.0 object term table in a memo field,
press F5 or right click and choose Browse Lexicon. Once you are in the
table, click Re:discovery Lexicon to see the term in the hierarchy.

To learn how to use the Nomenclature 3.0 system for classifying and naming
objects:

e Read the opening chapters in the book. Every site should have at least
one copy of Nomenclature 3.0. If you don’t have the book at your site,
contact the Park Museum Management Program or your bureau’s
museum property contact.

e Refer to the NPS instructions for using the book in the MH-1I, Appendix
G.

Yes. Bureaus may add terms to Nomenclature 3.0. Send requests for
additional terms to your bureau’s museum property contact. ICMS includes
the most recent list of additional terms. The Nomenclature 3.0 object list in
ICMS will be periodically updated to include the new terms. For the NPS,
refer to the MH-II, Appendix G, for instructions on submitting object terms.

Note: You cannot add classification categories to Nomenclature 3.0.

The NPS Classification Terms were chosen by various NPS discipline groups
to use in classifying cultural resources collections. The terms vary by
discipline.

You must use the NPS Classification Terms lexicon to classify cultural
resources collections (archeology, archives, ethnology, history). The
classification categories appear in tables within ICMS for Classification
Lines 1-4. Refer to Sections I-IV of Chapter 2 for information on cataloging
cultural resources collections.

The following appendices in the MH-II contain information on the NPS
Classification Terms:

e Appendix D: Archives and Manuscript Collections
e Appendix E: Archeology

e Appendix F: Ethnology

e Appendix G: History

No. You cannot add classification terms or categories. The classification
tables are locked tables.
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. HCO

What is the HCO?

How do | use the HCO
lexicon in ICMS?

Where do | go to find
information on the HCO?

Can | add classification
terms to the HCO?

ITIS

What is ITIS?

How do | use ITIS in ICMS?

Where do I go to find
information on ITIS?

Can | add classification
terms to ITIS?

How do | update the ITIS
table in ICMS?

ICMS User Manual (2015)

The HCO is a system for classifying natural history specimens. The NPS
developed the system in collaboration with discipline-specific specialists in
NPS and other institutions.

You must use the HCO in ICMS to classify geology specimens in the
Natural History directory. The classification categories appear in tables
within ICMS for Classification Lines 1-4 for geology. Refer to Section VI
of Chapter 2 for information on cataloging geology collections.

Note: Biology and paleontology specimens now use the ITIS system to
complete the classification. Refer to Sections V and VII of Chapter 2.

The HCO is part of the MH-II, Appendix H: Natural History. The appendix
includes an explanation of how to use the HCO.

No. You cannot add terms to the HCO.

The Integrated Taxonomic Information System (ITIS) is a partnership of
U.S., Canadian, and Mexican agencies (ITIS-North America); other
organizations; and taxonomic specialists. ITIS is also a partner of Species
2000 and the Global Biodiversity Information Facility (GBIF). It is an online
database that includes authoritative taxonomic information on plants,
animals, fungi, and microbes of North America and the world.

You can use ITIS in ICMS to complete the classification fields for biology
and paleontology specimens in the Natural History directory. The ITIS
database is accessed through the Find Specimen link when adding, copying
or modifying a biology or paleontology record. Refer to Sections V and VII
of Chapter 2 for information on cataloging biology and paleontology
specimens.

You are not required to use ITIS to complete the classification fields. You
can enter classification information individually if the specimen you are
cataloging does not exist in the ITIS database.

Information about ITIS can be found on their web site. Using Internet
Explorer, go to http://www.itis.gov.

No. You cannot add terms to ITIS. ITIS continually updates their database
with new information. Updates to the ITIS database will be available in
ICMS through the ITIS Tables Update option on the Tools menu (see E.5
below).

Additional terms from paleontology collections that do not appear in the ITIS
database have been added to the ICMS copy of the database.

You must be connected to the internet to download the ITIS update files. To
update the ITIS table in ICMS:

e (o to the Tools menu and select ITIS tables Update
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I ITIS Tables Update
ITIS updates | Download ITIS | Unzip and Inskall

Check For Updates  Click the link to check for newer ITIS tables on Re:discovery's FTP site,
(The system date will be compared to the FTP tables date.)
The response from the FTP server will appear in the box below,

Response from FTP server:

Note: If the ITIS update zip file was provided to you with an upgrade or you
downloaded it from the Rediscovery ftp site at
ftp://ftp.rediscov.com/ICMS/ITIS, skip to the Unzip and Install tab
instructions below.

e Click Check for Updates to determine if you have the latest version of
the ITIS tables.

e Ifthe response indicates that there is an update available for your
system, click on the Download ITIS tab.

2 IMIS Tables Update
ITIS updates | Download ITIS | Unzip and Install

URL of file to download From FTF site:

ftp:f{ftp.rediscoy. com/MNPSupdates/Itis Tables, zip

Download file ko this local Folder: Browse

Critemp

Ciownload

Mo inkernet connection available,

e Enter a location to save the download file on your computer. You can
also click the Browse link to select a folder.

e  Click the Download link to begin the download.

e  When the download is complete, click on the Unzip and Install tab.
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F. AAT

1. Whatis the AAT?

ICMS User Manual (2015)

I ITIS Tables Update
ITIS updates | Download ITIS | Unzip and Inskall

Full path ta zipped ITIS file: Browse
CiitemplItisTables. zip

Update Re:discovery ITIS tables

e  Check that the full path to the zipped ITIS file is correct, or click the
Browse link to locate the ItisTables.zip file.

e To install the ITIS update, click Update Re:discovery ITIS tables. The
processing steps will be displayed.

& ITIS Tables Update

ITIS updates | Download ITIS | Unzip and Install

Full path to zipped ITIS file: Browse
CiitemplItisTables.zip

Update Re:discovery ITIS tables

Taxon_authors_|kp table loaded. H
Taxon_unit_tvpes table loaded.

Loading Taxonomic_units table- Step 1 of & finished.

Loading Taxonomic_units table- Step 2 of & finished.

Loading Taxonomic_units table- Step 3 of & finished.

***Final 3 steps may take several minutes each.

Beqin Loading Taxonarnic_Units data

Taxonomic_Units data load complete- Step 4 of & Finished. =
Taxonomic_nits Fullame Column Creation complete- Step S of & finished.

Taxonomic_nits Fullame Colurmn Indexing complete- Step 6 of 6 finished.

Mew ITIS tables have successfully loaded.

&

e When the update has completed, click the X to close the window.

The Art & Architecture Thesaurus (AAT) provides a standardized vocabulary
for fine arts, architecture, decorative art, and material culture of the Western
world. The AAT is an evolving indexing language that is open to user
suggestions. It is:

e constructed as a list of single concepts

e arranged within facets (see F.3. below)

displayed hierarchically and alphabetically

designed for indexing and retrieving

The AAT isn't a classification system, data structure standard, or cataloging
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2. Whatis a thesaurus?

3. What are AAT facets and
hierarchies?

4. How do | use the AAT
lexicon in ICMS?

Appendix E/Lexicons

system. It doesn't contain personal, corporate, building, institutional, or
geographic names or historic events.

The AAT defines a thesaurus as "the controlled vocabulary of an indexing
system, arranged in a known order and structured so that synonymous,
hierarchical, and associative relationships among terms are clearly displayed
and identified by standardized relationship indicators."

A well constructed thesaurus:

establishes a preferred form of a term

links synonyms and spelling variants

e provides consistency for information retrieval

e provides authority for usage of the term

e uses classification principles to structure terminology

There are § facets and 35 hierarchies in the AAT:

e A facet is a homogeneous class of concepts. Members within a facet
share characteristics that distinguish them from the members of other

classes.

Example: Marble falls within the Materials facet. Impressionist falls
within the Styles and Periods facet.

e A hierarchy is a homogeneous grouping of terminologies arranged
within the 8 facets. Hierarchies display relationships between terms.

Example: Relief prints include woodcuts, relief etchings and wood
engravings.

You can use the 44T in several ways in ICMS:

e On the history record, use the Term AAT field to record a term for the
object. Refer to Section IV of Chapter 2 for information on cataloging
history objects.

e From any memo field in the program, you can access a list of 44T and
Nomenclature 3.0 terms to use as vocabulary.

e  Use the AAT in a word search to extend the search to include related
words in the lexicon. Refer to Section H below.

Note: To access the 44T in a memo field, press F5 or right click and choose
Browse Lexicon. Once you are in the table, click Re:discovery Lexicon to
see the term in the hierarchy.

| You are not required to use the AAT.
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5. Where do I go to find

information on the AAT?

Can | add terms to the AAT?

Browsing the Lexicons

How do | access the browse

lexicon feature in ICMS?

ICMS User Manual (2015)

To learn how to use the AAT:

e  Purchase or borrow the printed edition of the A47. The Bureau does not
supply the 44T to units. Use of the 44T is optional.

e Take a training course on how to use the A47T. Contact the Getty Art
History Information Program for information on training courses.

For information on the AAT, contact:

The Getty Information Institute
1200 Getty Center Drive

Suite 300

Los Angeles, CA 90049-1680
310-440-6379

No. You cannot add terms to the A4T lexicon within ICMS. However, you
can submit terms to the Getty Art History Information Program for
consideration. Re:discovery Software, Inc. will periodically update the 4AAT
lexicon in ICMS as updates are released from the 44T.

You can access the browse lexicon feature from any record. To access the
browse lexicon screen:

e  C(Click the Lexicon button % on the button bar

e Under Go To on the View menu from most places in the software,
choose Lexicon.

e From a field using the lexicon as the authority table, press F5 or right
click and choose Zoom. Then click Re:discovery Lexicon. Note: If the
field is a stacked authority field, you will have to expand it first by
pressing F5 or F12 and then press F5 in the single lexicon entry line.

e  When in Add, Copy or Modify mode, right-click in a memo field and
choose Browse Lexicon. Then click Re:discovery Lexicon.

G R =
HFHE Edit View Help

EEEI

Nomenclature 3.0>

Lexicon [fiomendiatare 3.0° [~ Term Relationship
ferm Laakip 3 E DISTRIBUTION & TRANSPORTATION ARTIFACTS
Eqand Tree  CollapseTree CERTAIC AN AMEACE i
PERSONAL ARTIFACTS T NPS —NOM —.. NM3 notation: Definiton: Art

5 z""NmE” T RECREATIONAL ARTIFACTS T S —NOM ... 43 otation: Definton: Art.. &
{- BUILT ENVIRONMENT ARTIFACTS
- COMMUNICATION ARTIFACTS
- DISTRIEUTION & TRANSPORTATION ARTIFACTS
| rorrasims Term [Nomendature 3.0
i+ PERSONAL ARTIFACTS
+ RECREATIONAL ARTIFACTS
++ TOOLS & EQUIPMENT FOR COMMUNICATION
£ TOOLS & EQUIPMENT FOR MATERIALS Department Language
}+ TOOLS & EQUIPMENT FOR SCIENCE & TECHNOL....
- UNCLASSIFIABLE ARTIFACTS

Lexicon(s)

NPS —NOM —... NM3 notation: Definition: Arti..

Term | Relationships for Lexican NM3

Lexicon(s) NM3

Classification |NM3

Approved [No

Scape Note

See Reference

See Also

Notes

Added by on
Selected Term: Nomenclature 3.0 | Descriptor: Nomenclats View Mode

Nemanciseure 3.0 for Mussum Catsisging: Thie! aditon of Robare 6. Chenkalls Syseem for Clsssifing Man-Mack Objacss
by Paul Bourcier, Ruby Rogers, and the Nomenclature Commities, AASLH Book Seres, This ELECTRONIC VERSION i unde fcense from AkaMia Press subiect to the terms of the foense,
© AkaMea Press, A Division of Rowman Litkfeld Publishing Group, Inc,
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2. How do | browse a lexicon
in ICMS?

From Term Lookup

Appendix E/Lexicons

The Lexicon window consists of 3 panes just like the main system screen.
These panes are resizable using click-and-drag to resize them.

The Navigation Pane on the left shows you the lexicon in a tree view and
lets you navigate terms using the hierarchy.

The Record Pane on the bottom right shows you the currently selected
term record. The Term tab contains information about the classification
of the term while the Relationships tab contains related terms (Broader,
Narrower, Use For and Equivalent, Alternate, Related, UK, and UK
Alternate).

The List Pane on the upper right displays the selected term’s most
immediate relationships as entered on the Relationships tab in the term’s
record. Just like in the List Pane of the main system, you can click on
the column headers to resort and filter the related terms.

Simply double-click a term in the Navigation Pane to load it into the Record
Pane, see its relationships in the List Pane, and to expand it in the Navigation
Pane to display its sub-terms.

There are several ways to navigate the hierarchical lexicon.

You can use the Term Lookup just above the Navigation Pane.
You can use the Tree in the Navigation Pane to find a term.

You can use the List Pane to load a term by simply double-clicking on
the term.

You can use the Breadcrumb at the top of the window just below the
button bar. Click on any term in the breadcrumb to load that term.

If you know what term you want to view but do not know what lexicon(s) it
is in or where it falls in the hierarchy, you can go directly to it using the
Term Lookup field.

e  Click the % icon in the Term Lookup field, press [F5], or start typing

the term and the Term Selector window will open showing the list of
lexicon terms.

Term Selector B_ - @
Search: documentary artifacts| Find
View Add Edit Delete
Term Description IJ
¥ | DOCUMENTARY ARTIFACTS =
documentary papyri AAT
documentary papyrus AAT
documentary photograph AAT
; documentary photographs AAT
I documentary photography AAT %]
|| Advanced Options Select  Cancel

Selected: DOCUMENTARY ARTIFACTS

Note: As you type in the Search field, the list will take you to the term. The
description column indicates in which lexicon(s) the term is found.
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From the Navigation Pane

ICMS User Manual (2015)

e  When you find the term you want, click Select. That term will load into

the Record Pane, its related terms will display in the List Pane, and the
Navigation Pane will show where it falls in the hierarchy.

Nomenclature 30> COMMUNICATION ARTIFACTS> DOCUMENTARY ARTIFACTS> £
Lexicon Nomendature 3.0° ] Tem.

e biia 143 otation: Defnition: Tok..
R B CUENTAR Y ARTIFACTS g memore
e @ finandial records N NM3—AAT N3 notation: Definition: Rec..
N — . . records NT NM3—-AAT  NM3 otation: Definition: Rec...
‘L e | legal doaments T 13 AAT N3 nataten: Deften: Doc... o
| - COMMUNICATION ARTIFACTS o —
M Term | Relationships for Lexicon NM3
i (& DOCUMENTARY ARTIFACTS ‘
i adminstrative records
m D britory Dosnoils Term [DOCUMENTARY ARTIFACTS ]
\[ 1+ ol feciod Lexicon(s) |NM3 —4PS =]
government records
L e Classification | M3 ~PS =
| Instructional Documents Department | . language | ]
B i-- legal documents Y |
- iterary Works s
i~ memorabiia Scope Note [NM3 notation: Definition: Artifacts originally created to communicate information to people. Unlke Adver tising
‘ o = Media, a Docmentary Artifact s not generally intended to elict a specific response in regards to products,
er DocLment

See Reference

See Also

EE|EE| e

Notes W’a notation: Changes: Changed from: Documentary Artifact Source: RNMC

Select Previously \ Term Added by rosy on 03/08/2015

Selected Term: DOCUMENTARY ARTIFACTS | Descriptor: View Mode

Nemencisture 3.0 for Museum Catabogings Thir ecioon of Robert G, Chenfalls Systam for iassifying Man-Made Objects
by Paul Boursier, Ruby Rogers, and the Nomencisturs Commttee, AASLH Book Garies. This ELECTRONIC VERSION i under icensa from Altahiia Press subject 8 the tarms of the fcense.
© Akaira Press, A Division of Rowman Liefield Pubishing Group, Inc.

You can use the tree in the Navigation Pane to navigate through the hierarchy
to find a term. Simply double-click a term in the Navigation Pane to load it
into the Record Pane, see its relationships in the List Pane, and to expand it
in the Navigation Pane to display its sub-terms.

e Choose the lexicon you want to navigate through using the pull down
menu in the Lexicon field. Your choices are:

AAT

HCO
Nomenclature 3.0
NPS Classes
NPS Rev Nom
Park Lexicon

e  The tree in the Navigation Pane will refresh to show you the most
immediate narrower terms of the nomenclature selected.

— - —
Re{ Re:discovery Lexicon = 4
File View  Help I
=K JY |
Nomenclature 3.0> z
Lexicon § Term Relationship | Lexicon(s)  Scope. -
oLk b DISTRIGUTION & TRANSPORTATION ARTIFACTS K3 otation: Defiition: Art
COMMUNICATION ARTIFACTS T NP5 ~NOM .. M3 notation: Defiition: Art
Bpand Tree  CollapseTree =
L — - PERSONAL ARTIFACTS [0 NP ~NOM .. NM3 notation: Definition: Art...
4| @ Nomendatre 30 | RECREATIONAL ARTIFACTS T NES —1OM ... N3 nottion: Defnon: Art.. o)
" + BULLT ENVIRONMENT ARTIFACTS -
= Term | Relationships for Lexicon NM3.
- COMMUNICATION ARTIFACTS ‘
i~ DISTRIBUTION & TRANSPORTATION ARTIFACTS
B FURNISHINGS Term |Nomendature 3.0 |
|| - PERSONALARTIFACTS Lexicon(s) |3 [~
[ |-mecReATiOwAL aRTIFACTS
| b ToOLs 8 CQUIPHENT FOR CoMMUNICATION G [T =]
] TOOLS & EQUIPMENT FOR MATERIALS Department | | Language @]
I - TODLS & EQUIPMENT FOR SCTENCE & TECHNOL....
= Approved o ¥
UNCLASSIFIABLE ARTIFACTS
Scope Note =]
¥
See Reference =]
sl
See Also =]
ud
Vo= _,|
]
u Added by _on
Selected Term: Nomenclature 30 | Descriptor: Nomenclati | View Mode |

Nomendsture 3.0 for Museum Catstoging: Thid editin of Robert G. Chenhal's System for Glssséing Man-ade Objects
by Paul Boucis, Ruby Rogers, and the AASLH Book Series. Th E AkaMica Ject to the terms of the foense.
© Ahabiza Press, A Division of Rowman Liisheld Publihing Group, Inc.
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From the List Pane

Breadcrumb

H. Using Lexicons with
Advanced Search

1. How do | use lexicons with

the Advanced Search
function?

Appendix E/Lexicons

e Double-click on the next term you want to expand to see its most
immediate narrower terms.

Example: Double-click COMMUNICATION ARTIFACTS. It will
load that term into the Record Pane, show its related terms in
the List Pane, and display its location in the hierarchy in the
navigation tree.

e Keep double-clicking terms in the tree until you get to the desired term.
(You can also use the Expand Tree and Collapse Tree links to open or
close the different levels.)

Note: At the bottom of the Navigation Pane, click Select Previously
Viewed Term to load the term you were just looking at in the Record Pane.

As you navigate around in the lexicon, you can load any term you see in the
List Pane by simply double-clicking it. It will become the selected term and
will load that term into the Record Pane, show its related terms in the List
Pane, and display its location in the hierarchy in the navigation tree.

At the top of the screen, below the button bar, is a Breadcrumb showing you
the trail of the direct path down the hierarchical lexicon from the topmost
parent term to the currently selected term.

File Edit View Help
Eep 3@ 4D

Nemenclature 20> FURNISHINGS> HOUSEHOLD ACCESSORIES> Other Household Accessories> Bellpull> l

Lexicon | nomendature 3.0% [~ Term
Term Lookup & » Other Household Accessories

Expand Tree  CollapseTree
term
& Nomendature 3.0
& FURNISHINGS
5 HOUSEHOLD ACCESSORIES
& Other Household Accessories

Term | Relationships for Lexdcon NM3

Term |Belipul

Lexicon(s) [MOM --NM3

You can click on any term in the Breadcrumb to load that term into the
Record Pane.

You can use the lexicons within the program to specify terms that you want
to add to a search. Using terms within the lexicon, you can extend your
search to associated, narrow, broader, related and sibling terms.

To extend an Advanced Search using a lexicon:

e Inthe Advanced Search window, enter a term in the search box.
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ST ——

File Actions Teols Help

What do you want to find?

In the Search box below, type the word or phrase you want to find. Press Ctrl-5 or click Begin Search to launch the search. If any records
are found , from the Search Results tab press Ctrl-U or click Use Search Results to load the search results as a Tag Set into the main syste

Advanced Search | Search Results

Limit Records Returned To Default (10000) lad ||| Lexicon Options [Wihere to Search
Include... Reset to Default l
Search:
Froper Term
boot Associated Terms
| Narrower Terms
Broader Terms
8] elscd tems ]
Word Variants
Show lexicon terms to search
BOOT, BALMORAL -
BOOT, CARRIAGE El
[] BOOT, COWBOY =
[ BOOT, DIVING
[] BOOT, HIKING
BOOT, HIP -
(|
Check All Uncheck All B
Check the words that you wish to exclude i
|v] More Options... from the search.
Beqin Search Cancel
boot

e  Check the appropriate box on the right under Lexicon Options to extend
a search. By clicking on the box, you can add or remove a check mark
to designate the terms to include. You can also click Reset to Default to
clear all checked boxes. The lexicon options are:

Proper Term — will look for the word you enter, plus the proper
usage of the word. For example, if you search for
IMPRESSIONISM, Advanced Search will also look for
IMPRESSIONIST.

Associated Terms — will look for the term you enter, plus any
terms associated with it, according to the lexicon.

Narrower Terms — will look for the term you entered, plus
narrower terms as defined by the lexicon. If you enter SHOE,
search will also look for MUKLUK.

Broader Terms — will look for the term you entered, plus broader
terms as defined by the lexicon.

Related Terms — will look for the term you entered, plus Related
terms as defined by the lexicon. For example, if you enter MUGS,
search will also look for CUPS.

Note: If you do not see the Lexicon Options tab, check the More Options
box on the lower left of the Advanced Search window.

e If you would like to see the terms that will be searched, click Show
lexicon terms to search and the list will populate with the terms from the
lexicon that are linked to the term you entered according to the lexicon
option(s) you chose.

Note: If you do not want to search all the terms listed, you can check terms
in this list that you want to exclude from the search.

During the word search, you will see the various lexicon terms flash on the
screen. The search results will include the keyword(s) and the other lexicon
terms you selected. When the search is complete, the lexicon terms that were
searched will appear in the Related Words Searched For box on the Search
Results tab.
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. Creating a Park Lexicon

1. What is a park lexicon?

2. Where do I go in the
program to create a park
lexicon?

3. How do I create a lexicon?

4. How do I add a term to the
park lexicon?

Appendix E/Lexicons

I Advanced Word Search |Z]|E]@

Flle  Actions Tools Help

What do you want to find?

In the Search box below, type the word or phrase you wantto find, Press Ctrl-S or click Beagin Search to launch the search. If
any records are found , from the Search Results tab press Ctrl-U or click Use Search Results to load the search results as a Tag

Advanced Search | Search Results

Records Found: 10 Records Returned: 10
Search Expression Related Words Searched For
boots BOOTS BY FORM;;«BOOTS BY FORM > BOOTS BY
FUNCTION, ;«BOOTS BY FUNCTION>;;BOOT
Directary Caption Module Narme d Marme Details A
o} PARK - Cultural Reso, .,
3 - PARK - Culkural R...

PARK - Culkural R...

Refer to Section I of Chapter 7 for information on how to conduct a word
search.

A park lexicon is a vocabulary of terms and relationships that you develop
from the specific material at your site. For example, you may want to
associate specific names or objects as narrower terms under various broad
terms. You can then do one search to find all the records that contain
information on objects or people associated with the terms.

To create a park lexicon you must go to the Re:discovery Lexicon screen. To
access the screen:

e  (Click the Lexicon button % on the button bar, or

e Under Go To on the View menu from most places in the software,
choose Lexicon.

The Re:discovery Lexicon window will open.

Note: You don’t need special security access to create a park lexicon.
Creating lexicons requires a lot of time and effort. You must precisely define
the terms you want to use. You must also precisely define how the terms fit
within a hierarchy of broader, narrower, and synonymous terms.

Before creating a park lexicon, it’s a good idea to talk to other sites that have
created lexicons. Contact Re:discovery Software, Inc. at 434-975-3256 for
the names of sites or other museums that have created their own lexicons.

To add a term to the park lexicon:

e  Choose Park Lexicon from the Lexicon pull down in the upper left.

e  Click the Add button m on the button bar, press [F9], or select Add
New Term on the Edit menu.

e The Record Pane will open a new record ready for you to fill in and Add
Mode appears in the lower right of the Status Bar.
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ParkLesican>

Expand Tree  Collapse Tree

Selected Term: Park Lexicon N Add Mode:

TX Re: discovery Lexicon [ =ES]

| Fle Edt Vew Help

Lexicon Term Relationship  Lexicon(s)  Seope
Term Lookup =

Term
Park Lexicon

Term " Relationships for Lexicon PRK

Term
Lexicon(s) prg
Classification
Department | tsnauage [¥]
Approved bo [¥]

Scope Note
See Reference
See Also

Note

saveandClose  SaveandAddAnother  Save  Cancel

Added by on

Fill in the classification information on the Term tab.

Term: Enter the new term. This is a required field.

Lexicon(s): The lexicons this term is a part of. PRK will
automatically be entered. You cannot edit the field.

Classification: Enter PRK if this is a preferred term in the lexicon.

If this field is blank, the term is not considered a preferred term by the
system. Entering non-preferred terms in the lexicon can be a useful
way to point non-preferred terms to preferred terms. When viewing
the relationships in the Navigation Pane, preferred terms are displayed
with Preferred Term next to them if they are related to a non-
preferred term (Classification is empty).

Department: Large Institutions may want to indicate which
department (archives, historical, art, etc.) entered the term. This is a
user built authority field.

Language: Institutions managing multi-cultural collections may
want to indicate the language of origin for the term.

Approved: Used to indicate whether the term is a generally approved
term. It is not used by the system to determine whether a term is
accepted or not in the formal lexicon. This approval field is for client
reference only. For example, a user may enter terms that may need to
be approved for use by a supervisor.

Scope Note: This is an optional field containing an instructional
statement that defines or clarifies the usage or meaning of the concept

and how it fits into the context of the nomenclature.

See Reference: This is an optional field, used to indicate references
for the derivation for the term and its usage.

See Also: This is an optional field to list other terms that are similar,
but not necessarily approved terms.

Note: This is an optional field to be used however the institution sees
fit.
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e To create relationships between this term and other terms in the lexicon,
click on the Relationships for Lexicon PRK tab.

Note: The definitions that follow are general ones to help users begin to
understand a Lexicon's structure. For additional information on Lexicons,
users should refer to the Getty Information Institute's AAT website at
http://www.getty.edu/research/conducting_research/vocabularies/. Also, the
introduction to Nomenclature 3.0 for Museum Cataloging: Third edition of
Robert G. Chenhall’s System for Classifying Man-Made Objects has
information on Nomenclature 3.0.

2 Re: discovery Lexicon

|| File Edt vew Help
Park Lexicons
Lexicon Term Relationship  Lexicon(s) Scope
Term Lookup &

Expand Tree  Collapse Tree
Term
b - Park Lexicon

Term | Relationships for Lexizon FRE

E o
33
E E

Use For and Equivalent

K

Alternate

E

Related

Uk

E E

UK Alternate

E

v

Selected Term: Park Lexicon M addd Mode:

Broader Terms: Broader terms include the "super group(s)" to
which a term belongs. It is also known as the “parent term”. Nail
might have a broader term of WOODWORKING T&E. This is a
required field. If you do not enter a broader term, the system will fill
in ‘Unassigned’ as the broader term. You must associate the new
term with a Broader Term, even if it is just the top level ‘Park
Lexicon’ term.

Narrower Terms: This relationship relates to subordinate terms. It is
also known as the “child” term. If WOODWORKING T&E is a
broader term of NAIL, then NAIL is a narrower term of
WOODWORKING T&E.

Use For and Equivalent: When several formats of a term refer to
the same concept, but there is a preferred and non-preferred format,
they are equivalent. These are usually terms that appear in different
languages or formats. The preferred format is indicated by a
designator in the Classification field and has [Use Instead] following
the term. The non-preferred form is followed by [Use For]. For
example, “Concrete Art” is the preferred term and should be used in
place of “art, Concrete”, “Art Concret”, and “Konkrete Kunst”.

Alternate: This will indicate valid forms of the term that may be
used in place of the selected term. An alternate term is usually a
singular form or a different part of speech (adjective or possessive).
For example, Impressionism is an alternate term for Impressionist, but
Impressionist is the preferred term. The Classification field for
Impressionist indicates the lexicon where it is accepted.

E:14 ICMS User Manual (2015)



Related: Related terms are similar concepts but not identical terms.
Both can be considered preferred object terms rather than being
related through hierarchical or equivalence relationships.

UK: This will indicate a variation in spelling of the term recognized
in the United Kingdom. Color could have a UK relationship to
colour.

UK Alternate: This will indicate a valid form of the term in the
United Kingdom that may be used in place of the selected term such

as shoppe for shop.

The Relationship fields are stacked lexicon lookup fields so you can
select more than one term of the same type of relationship.

e  Save the new term using one of the Save Options
Save and Close: Use to save the new term and close the Lexicon.

Save and Add Another: Use to save the new term and immediately
bring up a new window in Add mode.

Save: Use to save the new term and keep the Lexicon window open.

Note: Ifthe term is already part of another lexicon, you will receive a
message indicating that the term already exists. To add the term to your park
lexicon to set up additional relationships, you must use the Add Existing

Term to Lexicon option on the Edit menu, or click the EII]: button on the
button bar. The term field will then allow you to choose the term from a
lexicon term selector window. You will only be able to edit the Note field
and add relationships on the Relationships for Lexicon PRK tab. All other
fields will be locked.

5. How do I edit a park lexicon  You cannot edit terms in locked lexicons such as the AAT and Nomenclature

term? 3.0, but you can edit terms in the Park Lexicon. You will be warned if you

cannot modify the term because it is part of a locked lexicon. To edit a term:
e  Select the term in the Park Lexicon you want to edit.

e  Click the Modify button on the button bar, press F10, or select Modify
This Term on the Edit menu.

e The Record Pane will open the current term ready for modification and
Modify Mode appears in the lower right of the Status Bar.

e Make any necessary changes to the term and its relationships.
e Click Save and Close to save the term.
6. How do I delete a park You cannot delete a term from a locked lexicon such as 447 and
lexicon term? Nomenclature 3.0. You will be warned if you cannot delete the term because
it is part of a locked lexicon.

e  Select the term you want to delete.

e Select Delete This Term from the Edit menu.
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If the term has relationships set up with other terms, a warning message will
indicate that there are other terms related to the term you are deleting.
Deleting the term will permanently remove all relationships to other terms in
the lexicon.

Note: If the term is part of a locked lexicon and you want to remove it from

the park lexicon, select Remove This Term From Lexicon from the Edit
menu.
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